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Welcome

Welcome to SCO® SQL-Retriever™, part of the
Vision2K suite of products from SCO.

This book introduces you to SQL-Retriever and
gets you up and running quickly. You should read
it if you want to use SQL-Retriever to access UNIX
databases.

In this book you’ll find out why SQL-Retriever is
the easiest way to access UNIX databases from
Microsoft Windows.

For instructions about installing Vision2K on PCs
and on UNIX host systems, see the CD insert or
the Reference book.
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What is SQL-Retriever?

Open Database Connectivity (ODBC) is Microsoft’s strategic interface which
eases the burden of data access by creating an open and powerful means of
accessing a wide range of database systems.

SQL-Retriever uses the ODBC standard intelligently to deliver a high
performance Windows to UNIX client/server solution. Its unique
architecture lets Windows applications and developer tools (such as
Microsoft Access, Excel and Visual Basic) make concurrent connections to
multiple databases like Informix, Oracle, and Ingres.

Users of Windows applications can access corporate information
transparently, without needing to learn the SQL language, how the data is
structured, or where it is stored. UNIX data becomes available with no more
than the click of a mouse.

If SCO SuperVision is in use at your site, then PCs running SQL-Retriever
can be managed remotely by a System Administrator. SuperVision provides
facilities for remote configuration; distributing data files; managing user’s
desktops; creating script files to perform tasks on PCs; controlling and
monitoring PCs remotely.

No other ODBC product takes such advantage of both the Windows and
UNIX environments, which is why SCO SQL-Retriever is the complete
solution to ODBC connectivity.
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If you’ve used SQL-Retriever 3.5

before

Take a look at how SQL-Retriever has changed since version 3.5.

What happened to ODBC Setup?

Previously the Microsoft ODBC Setup program used to install the PC part of
Vision ODBC driver had to be run separately after the SQL-Retriever Setup
program. Now ODBC Setup has been more closely integrated with SQL-
Retriever Setup and is run silently during the installation process to install
the Vision ODBC driver. Use Control Panel to configure ODBC data sources
following the installation of SQL-Retriever.

How do | configure hosts?

Previously all remote host computers had to be configured manually. Now, if
you use SQL-Retriever on a network, UNIX computers that are available to
you are automatically configured in the Vision Communications database by
the Host Finder program. This program runs after installation and again at
intervals, and by default will detect hosts with Vision software installed and
XDM hosts. You can still configure hosts manually, either from Control
Panel or from Host Explorer.

Details of the transport mechanism used to connect your PC to a UNIX host
are now configured from Control Panel.

SQL-Retriever Lite SQL-Retriever Lite does not use Vision

Communications; you need to supply all the necessary host configuration
details using the SCO Vision ODBC Setup dialog box.

What happened to the VT52 Terminal Emulator?

Recent versions of Windows come with a terminal emulator (Telnet) that can
be used to check connections and interact with the DBMS. The VT52
Terminal Emulator, previously used for these purposes has now been
withdrawn. To run Telnet, display the Run dialog box and type telnet.

What happened to File Transfer?

File Transfer has been replaced by Unix Neighborhood and Host Explorer,
which provide file browsing and management facilities for UNIX hosts in
addition to allowing files to be copied between UNIX and the PC.

SQL-Retriever Lite SQL-Retriever Lite does not provide file browsing and
mangagement facilities. If this is a requirement, you should use SQL-
Retriever.
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What happened to LPD?

The print functionality of LPD is now available from the Print Server that
runs on the PC and listens for print requests. It also acts as a client for
sending print requests to a remote UNIX system. The Print Server is started
automatically when a print request is received.

SQL-Retriever Lite SQL-Retriever Lite does not provide print
functionality. If this is a requirement, you should use SQL-Retriever.

What happened to the PC-Connect Protocol?

The PC-Connect Protocol has been replaced by the Universal Session
Protocol, which performs essentially the same function of multiplexing many
channels over a single connection.

SQL-Retriever Lite SQL-Retriever Lite does not provide any
communications protocols. If this is a requirement (for example if you
require an error-correcting serial connection), you should use SQL-Retriever.
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What’s new in this version

This version of SQL-Retriever contains these new features and facilities.

Windows 2000 client support

Vision2K now supports both Windows 2000 Desktop and Windows 2000
Server.

File access across a firewall

You can now use Unix Neighborhood to access files on FTP servers outside
your intranet when your firewall would previously have prevented this. To
allow files on FTP servers outside your firewall to be accessed, you need to
enable passive mode FTP.

To do this, double-click Vision Communications in Windows Control panel
and then click the Transports tab. Click the Advanced tab, click File Access,
and then click Settings. Click to select Use Passive Mode FTP.

Note that this option enables passive mode FTP in the Vision2K client
software. Not all FTP servers support passive mode FTP though.

Vision Communications Architecture configuration
wizards

To use all the Vision2K features over a modem or serial connection, you
need to create a transport that runs the Vision Communications Architecture
USP services via a proxy. Vision2K now provides the New Proxy Transport
Wizard to simplify the creation of this type of transport.

The New Unix Host Wizard is also provided if you prefer to manually add
hosts (in addition to those automatically configured by the Vision2K Host
Finder program) using a wizard-style interface.

To run the new wizards, click the Start button, point to Programs, point to
Vision, point to Accessories, and then click either New Proxy Transport or
New Unix Host
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What’s

in this book

In Chapter 1, “The Basics”, you’ll find out what’s on the Windows desktop,
and how to get more information from online Help. You’ll find out how to
configure an ODBC data source and create the demonstration database to
help you get started using SQL-Retriever to access UNIX data. You’ll also
discover what you must do in order to use SQL-Retriever with a serial or
modem connection.

In Chapter 2, “Beyond the Basics”, you’ll discover how SQL-Retriever can be
used to integrate remote data with popular Windows applications such as
Microsoft Access, Excel, and Visual Basic.

In Chapter 3, “The Possibilities”, you’ll learn about how you can browse
through UNIX files, run UNIX programs, set up remote printing, and send
messages to other users.



The Basics

Look in this chapter to find out how to get started
with SOL-Retriever.

You'll find out what’s on the Windows desktop,
and how to get more information from online
Help. You’ll find out how to configure an ODBC
data source and create the demonstration database
to help you get started using SOL-Retriever to
access UNIX data. You’ll also discover what you
must do in order to use SQL-Retriever with a serial
or modem connection.

CONTENTS

What’s on the desktop? ......ccceveeeeevierneeneennen. 2
What’s in the Vision folder or group? ........... 3
Getting Help c..eevveerniieniiicicieeceeeeeee, 4
Configuring an ODBC data source ................ 7
Creating the demonstration database.............. 9

Using a serial or modem connection .............. 13
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What’s on the desktop?

SQL-Retriever adds the Unix Neighborhood icon to the desktop. You will
already have a My Computer icon, and possibly a Network Neighborhood
icon if your PC is connected to an MS-DOS or Windows network. The Unix
Neighborhood item adds similar facilities to allow you to browse UNIX
servers. (Note that Unix Neighborhood is not provided with SQL-Retriever
Lite.)

st ez LY
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What’s in the Vision folder or group?

The Vision folder in the Start menu’s Programs folder may contain some or
all of the items shown in the following table, depending on the flavor of
SQL-Retriever installed and Setup choices. Some items may be in subfolders
of the main Vision folder.

Item

2

i

B ® ®w €

i @

Description

Admin Update can be used to update your PC from the
administration host if your PC is managed by
SuperVision. Admin Update is not provided with SQL-
Retriever Lite.

Connection Manager is used to manage the PC end of a
connection when a multiplexing protocol is used.
Normally this program is started automatically when

required. Connection Manager is not provided with
SQL-Retriever Lite.

Host Explorer can be used to browse remote hosts. Host
Explorer is not provided with SQL-Retriever Lite.
Message Pad displays text and multimedia messages sent
to your PC. Message Pad is not provided with SQL-
Retriever Lite.

Program Starter can be used to remotely execute a
program on a UNIX server. Program Starter is not
provided with SQL-Retriever Lite.

SQLGold is a Windows front-end to SQL databases
which allows you to test SQL-Retriever.

User Viewer displays a list of other Vision2K users, and
allows you to send messages to them. User Viewer is not
provided with SQL-Retriever Lite.

Vision Help starts the Vision2K Help.

SQL-Retriever Setup can be used to add more options if
you performed a partial setup.
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Getting Help

Online Help is the main source of information about Vision2K software.
There are four kinds of Help: an introduction to concepts; Help about
specific procedures; context Help about what you see on your screen; and an
online reference manual.

To get Help

¥ Click the Start button, point to Programs, point to Vision, and then click
Vision Help.

Help Topics: Vision2K [ 1=]

Cortents | index | Find |

Click a book. and then click Dpen. Or click another tab, such as Index.

Q How Ta...
Q Reference
Q Troubleshaoting

Open I Frrint | Cancel |

4 The list of Help topics appears. You can use the tabs in Help to search for
information in several ways.
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Tip

Some Help topics
contain green
underlined text.
You can click the
green text to see a
definition of the
term.

Tip

To scroll through
the Help Index,
type the first few
letters of the word
you want to search
for. The Index is
arranged just like a
book index. If you
don’t find the
entry you want, try
another entry.

To find Help through the Contents

¥ Click the Contents tab to find topics grouped by subject, and then follow the

instructions on your screen.

Click a topic. and then click Display. Or click anather tab. such as Index.

Q Introducing Vision2k.
':ﬂl How To.
Q Usze the Audio Server
Q Use Connection Monitor
() Use Host Explorer
@ Stating and Quitiing
Q Changing the Look. of the Windaw
m Working with Hosts

Adding a new liansport

Changing the name of a hast
Changing transpart properties
Changing usemame and password
Creating a host

(9] ) ) ) o) =) 2]

Dieleting a hast =l

Display I Frint... Cancel

To change host properties
1 In Unix Meighborhood ar Hast

properties pou want to change.
2 On the File menu, click Properties.
Tips

propeties.

* For Help on an itemn, click % at the
top of the dialog box, and then click.
the iterm.

« To return to the list of
topics, click Help Topics.

To find Help through the Index

¥ Click the Index tab to find specific topics listed alphabetically, and then follow

the instructions on your screen.

Corfents Index IFlnd |

1 Type the first few letters of the word you're looking for.

hosts, changing properties

2 Click the index entry you want, and then click Display.

hostrgr command =l
hosts
browsing
changing name
changing names
changing passwiords

changing user =3
canfiguring

configuning for modem connection

caonfiguring for OPEN LOOK

configuning for serial connection

creating

deleting

specifying Host options

specifying Script options

specifying Security options =l

Display I Efirit:... Cancel

0 cnange host properties

1 In Unix Meighborhood or Host

properties you want to change.
2 On the File menw, click Properties.
Tips

propeties.

* ForHelp on an item, click 2 atthe
top of the dialog box, and then click
the iter.

« To return to the list of
topics, click Help Topics.
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T

You can also use
your right mouse
button to click an
item on the
screen. Then click
What's This?

To find Help topics containing a word or phrase

¥ Click the Find tab to find all the topics that contain a specific word or phrase,

and then follow the instructions on the screen.

i
Help Topicz)

Help Topics: ¥i

Contents I lifdex ~ Find

1 Ivpe the word(s) pou want ta find

Ichanging host properties J Clear

2 Select some matching words to naraw your search

Optians

3 Click a topic. then click Display

[
it | Sitarl &,
Eitrdiid ovr
F Rebuild

Changing file or folder properties (Host Explorer)
falder i 3t Manager)

Ch rerl
Changing host properties (Hast Manager)
Changing transport properties [Host Explarer]
Changing transpart properties [Host Manager)

"

Optionsg

To change host properties

1 In Unix Neighborhood or Host

properties you want ko change.
2 On the File menu, click Properties.
Tips

propeties.

* For Help on an item, click 2 at the
top of the dislog box, and then click
the item.

Changing username and password [Host Explorer) =
16 T apics Found | I All wards, Begin, Auta, Pause ‘
Dizplay I it | Cancel |

4 To return to the list of

topics, click Help Topics.

To get Help on a specific item

¥ For information about an item in a dialog box, click % and then click the item.

Vision Communications
Hasts |Transp0rts Databaze Diagnosticsl

Host configuration.

Huost Transpart =

jupiter

Avtomatic

mars

:;Jpluto

zaturm

Lizts all the configured hosts. If & host icon has ared cross
aver it, it means that the host iz not currertly svailable. The
Transport column shows the transport that will be uzed to
connect to this host. If Automatic appears in this column, then
the transport will be chosen dynamically st connect time
depending on those available.

=

. a
Add. . | Remaove | Eropertles...l

o]

Cancel | Ll | Help

A pop-up explanation
appears. Click it to make it
disappear.
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Configuring an ODBC data source

You need to configure an ODBC data source before you can access data with
the Vision ODBC driver. You use ODBC Administrator to do this.

To configure an ODBC data source

v | Do one of the following:

+ For Windows 2000, click Start, point to Settings and click Control Panel.
Double-click Administrative Tools and then click Data Sources (ODBC).

+ For other versions of Windows, Click the Start button, point to Settings,
and click Control Panel. Double-click the 32bit ODBC icon.

B3 Control Panel ==
File Edt “iew Help

I (%) Contral Panel

it OB

IS8 Fevboard

@ Modems

) Mouse

28, Multimedia

,E.'_EI_ Metwork

:& Paszzwonds

@ Prirters

Q Fegional Settings

QSounds

& Vision Services

o B blwl@| of

=, Microzoft Mail Postoffice

h\r‘ision Communications

€1 0DBC Data Source Administrator [ 7]
User DSN | System DSN | File DSN | 0DBC Diivers | Tracing | Abou |
User Data Sources: .
Marne | Diriver -~
Microsalt dB ase Driver (*.dbf) Remave |
Stock Database Microsaft FosPra Driver (*.dbf)
i LConfigure... |
-
«| |
An ODBC User data source stores information about how ko connect to
the indicated data provider. & User data source iz only visible to you,
and can only be used on the cunent machine.
0Ok I Cancel Apni Help

< 2 Click Add.
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Create Mew Data Source

Seleot a diiver for which you want to set up a data source

MName IVersion I Company

Microsoft dccess Driver [*mdb)  3.50.2605
Microsoft dBase Diiver [*.dbf] 3.40.2505
Microzaft Excel Driver [*.xls) 3.40.2505
Microzoft FaPra Driver [+ dbf] 3.40.2505
Microsoft Paradox Driver [.db]  3.40.2505
tdicrosoft Test Driver [*tet; % csv]  3.40.2505
5L on ODRC 4.10.0000
SOL Server % 2850213
SOL Server Demo 3.0 Driver 3.00.0075

|

Microsoft
Microsoft
Microzoft
Microzoft
Microsaft
Microsaft
The Sant,
Microsoft
Microzsoft

0|

< Back I Finish I

Cancel |

<3 In the Installed ODBC
Drivers list, select
SCO Vision ODBC.

<4 Click Finish.

~5 Complete the configuration dialog box. If you are using the lite version of
the Vision ODBC driver, the dialog box will contain a Connection tab. You
need to use this tab to supply connection details for the database host. You
can get Help on an item by clicking the question mark button in the title
bar, then clicking the item.

SCO0 Yizion ODBC Setup EHE
General | Advanced | Diagnastics | Cache |

— Data source
Mame: Iscodemo
Diescription: ISCD Yigion ODBC Driver

—Databaze
Host: IiUDitBl ﬂ
DEMS: [Ingres =l
Mame: |scodemo
sermame; I
|zt e I
(I it I

(u] 4 I Cancel Apply Help

See ALso

For more information, look up “data sources” in the Help index.
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Creating the demonstration
database

To allow you to test the Vision ODBC driver, and follow the examples of
using it with popular applications described in the Vision2K Reference book,
you are recommended to create a number of demonstration tables.

You use the SCO SQLGold program to create the tables, but first you must
have created a data source called “scodemo”. See “Configuring an ODBC
Data Source” earlier in this chapter for instructions about creating a data
source. The “scodemo” data source should be associated with a test database
in which you can create tables. For instructions on creating or accessing a
database, look up “demonstration database” in the Help index.

To create the demonstration tables

~ | Click the Start button, point to Programs, point to Vision, and click SQL
Gold.

47 5QLGold - (untitled) M=
Ele Edt Databass Optiors Help
~Taal Box

) | sal [Tabies | gear [ =22l [ o ]r]

- SaL S

|

g o

[scAL [NuM [caps
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o=

[SiEse Dalahas§

e W I N =

C|

o o

Ready ‘SEHL ‘NIJM |l:AP5 4

Select Data Source EHE

File Data Source  Machine Data Source |

Data Source Mame | Type ‘ Description ;I

ACME Engineering User J
User SCO Vision DDEC Driver

Stock Dislabase User

A Machine Data Source is specific ta this machine, and cannot be shared
"Uzer" data sources are specific to a user on this machine, ''System' data
sources can be used by all users on this machine, or by a spstem-wide service.

(1] I Cancel | Help |

<2 On the Database menu,
click Open Database.

\ 3 On the Machine Data
Source tab, choose
“scodemo”.

Wait for the message “DB open” to appear in the status bar at the bottom

of the SQLGold window.

LGold - (untitled) [ O] =]
Edic Datebase Oplions Help
|

New

mhah.queﬂ Fl==] = [ [ [~~[11]

Save

Save At

Bt - |

g o

DB open ‘SEHL ‘NIJM |l:AP5 4

» 5 Select the SQL file Scodemo.sql.

<4 0n the File menu,
click Open.

Setup placed the SQL files in the \Program Files\Vision\Examples

folder.
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¥ 6 When the SQL statements appear in the window, click the Run button.

#3 SALGold - C:\Program Files\Vision\Examples\scodemo.sgl

Ele Edt Databass Optiors Help
~Taol Box

) | 501 |zables| gea [T =1 = [ T [ 1= [=>~]T1]

~S0L S|
[Ereate table customer ﬂ
(

custom_num integer not null,

fname chai(15].
Iname chaif15),
company char(20),
address1 char{20),
address2 char{20].
city char(15).
state char(2),
zipcode char(5).
phone char(18)

1

create table orders
(

arder_num integer nat null,

custom_num integer. =
1] | |

Choose Run buttan to execute [scAL [NuM [caps

When SQLGold has finished executing statements, the Ready message is
redisplayed in the status bar.

4 7 To confirm that the demonstration tables have been created, click the
Tables button.

< 8 Double-click the

“sales” table.

Cancel

sQL
Show |
[Eows |

n¥iews

items
manufact
nominal
orders

stock E h

A SELECT statement to query the table is generated and appears in the
SQL Statements pane.

» 9 Click the Run button.
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I

v 10 The sales table should appear, confirming that the tables have been
created successfully.

5 SQLGold - [untitled) [-[o[=]
Fle Edi Database Dptions Help
~Tool Box

[ ]| sar |isbies | Gear [ JEmer [ [ R 00 =10

~Results

[region  [target [actual
O East 100000 121000
2 West 160000 146000
3 West 150000 212000
O Midwest 190000 195000
5 |Geary  Jemy South 180000 204000
3
7
8

Mallory Betty South 170000 185000
Harris Ken East 120000 113000
Parker Greg Midwest 200000 238000

8 Rows And 5 Columns [scAL [Num [caps
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Using a serial or modem connection

In order to use the Vision ODBC driver, you must use a USP transport. If
you are using a modem or serial line, then you must configure the USP-Serial
or USP-Modem transport as described in the “Vision Communications
Architecture” chapter in the Vision2K Reference book.

If you have configured your modem as a TAPI device, then a host called
Modem will be created by the Host Finder program (responsible for
configuring hosts). You need to change the Modem host to use the
USP-Modem transport. Look up “hosts, configuring for modem connection”
in the Help index for further information.

SQL-Retriever Lite SQL-Retriever Lite does not provide direct serial line
support. If you want to use the lite version of the Vision ODBC driver over
a serial or modem connection, additional software providing TCP/IP
capability over a serial or modem connection is required.






Beyond
the Basics

Look in this chapter when you’ve mastered the
basics, and want to know more about how SQL-
Retriever can be used to integrate remote UNIX
data with popular Windows applications and
developer tools such as Microsoft Access, Excel,
and Visual Basic

CONTENTS

Microsoft ACCESS «..veerveereereiersierieereeeeeeenne 16
Microsoft Excel .c.c.eeevueerveeieiiiniieniiiiiceneeene 17
Microsoft Word .....ceeceeeeeeeeiieniienieenieeneeenne 18
Microsoft Visual Basic .....ccocceerveeerveeineennneene 19
Borland Delphi .....ccoeeeeeieeieiiieecieeeeieeeeeen, 20
Powersoft PowerBuilder........cccceeveericinncns 21

Troubleshooting ........cceeeeveveeeieeeieiieeeieenans 22
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Microsoft Access

Microsoft Access can be used with SQL-Retriever to provide a powerful and
friendly interface to remote SQL databases. With Access you can link tables

from a UNIX database source and then work with the data in the same way

as a local table. For example, you can:

» Use queries to view, change, and analyze the data.

e Design forms to enter data into the table.

* Create and edit reports to present the data effectively.

R, Microsoft Access H=]
Ele Edit “iew Inseit Fomat HBecods Tools Window Help

40 = 1 e o O H P e R S

g db3 : Database
Tathe
W custom_num Iname company address! =
» Sadler Sports Spot 785 Geary St
8 sl | 103 Philip Curtie Phils Sports | 654 Poplar
|| 104/ Anthony Higgins Play Balll East Shopping
|| 105 Rayrond “Wector Los Altos Sport 1899 La Lorna
|| 106| George Watson Watson & Son 1143 Carver Pl
|| 107 | Charles Ream Athletic Supplie 41 Jordan Aver
|| 108/ Donald Quinn Cuinns Sports | 587 Alvarado
|| 109 Jane Miller Sport Stuff Mayfair Mart
|| 110 Roy Jaeger A& Athletics 520 Topaz Wa
|| 111 Frances Keyes Sports Center | 3199 Sterding €
|| 112| Margaret Lawson Runners & Othe 234 YWyandotte
|| 113|Lana Beatty Sportstown B54 Oak Grove
— 114 Frank Albertson Sporting Place | 947 Waverly F‘j
- Record 14| [T T > [vale#] ot 18 | | iy
|Datasheet View [ NoM[ [ovR 2

See ALso

For more information, look up “Access” in the Help index.




Chapter 2 — Beyond the Basics 17

Microsoft Excel

There are many ways in which SQL-Retriever can be used to bring remote
SQL data to Microsoft Excel. SQL-Retriever allows Microsoft Query
(supplied with Excel) to retrieve and filter data from UNIX databases using
point and click mouse techniques. The data can then be returned to Excel for
presentation and analysis. You can format the data as you would any other
spreadsheet data. You can also use the SQLRequest worksheet function to
place items of external data in a specific cell or cell range on your worksheet.
The external data is updated each time you open the worksheet. In addition,
there is a number of ways in which more advanced users can create macros
for accessing external data.

X Micresoft Excel - Profitxls [_ O] %]
ﬁ Elle  Edit Wiew [nset Format  Tools Data  Window  Help =) ﬂ
Dlcz|m| glraly| &|mle| ] of ) =[] 42 & @|e w1 9w
[Fev ZIF = m|z|u|= =| 2| %], |l =-] Al -
A1 =] [
T =
Ocean Faradise, Inc =
Profit and Loss Account Seodema
Revenue The walues are obtained
Sales R 36 automatically from the remate
Cost of Sales 23017 database when this worksheet is
42113 opened.
Gross Profit 42113
Expenszes
Accommodation 4,723
Motor Expenses 2.809
Depreciation 850
Advertising 630
Bank Charges 243
Adrministration 1.024
10,239
Total Expenzes 10239
Met Profit [Loss) £31.880 2
1] 4] ¥ i Profit.xls Kl | ﬂJJ
Ready | [Bum=0 HUM I 2

See ALso

For more information, look up “Excel” in the Help index.
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Microsoft Word

SQL-Retriever allows data from UNIX databases to be displayed in a Word
document. Word can access external data using either Database fields in the
document, or WordBasic macros. A Database field inserted into a Word
document can be used to query an external database and return the result as
a table. You can update the field at any time to query the database again. You
can also use Microsoft Query (which will be available if you purchased Word
as part of Microsoft Office) to retrieve data using point and click mouse

techniques.
W Micresoft Word - Sales Report. doc [_[O]x]
@ Elle  Edit Miew [|nsert Format  Tools Table ‘Window Help _|5 5]

Dlz(@] S| »[ms(ef<r| o «=|-| o[- | mlm/=]e]] o
|Nnrma| =l |T\mesNawHﬂman =l = BIIlgl%‘VHEg_ =|E| i= '_l;
EE""l"z‘f'g"'.“"5"'s' R N I KN F XN EE Y|

Refer to the following table for the sales figutes for Ocean Paradise, Inc

Iname fname region target actual n
Adams Chuck | East 100000 121000
Atking Lee West 160000 146000
Ellis Hane: West 150000 212000
Cormers Paul Midwrest 190000 196000
Geary Terry South 120000 204000
Mallary | Bett: South 170000 185000
Harris Ken East 120000 113000
Parker Greg Midwest | 200000 238000

EEE | :
|Page 1 Sec 1 14 [[At52em Ln5  Col 7y |[REC| MR (S (ovA | R Al

-

See ALso

For more information, look up “Word” in the Help index.
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Microsoft Visual Basic

SQL-Retriever allows Microsoft Visual Basic to access remote UNIX data in
the following ways. You can use the data control to create simple database
applications to display and update external data without writing any code at
all. Data access objects such as Database, TableDef, Field and Index objects,
can be used to manipulate external databases with the minimum of
programming. As well as simplifying code, the data object model insulates
you from the underlying structure and mechanics of retrieving and updating
data. If you use the Enterprise Edition of Visual Basic, you also have the
option of using the Remote Data Objects (RDO) programming model to
access external data. It is also possible to develop applications that call the
ODBC API directly, although this method is more complex to implement.

The SQLGold application supplied with the Vision ODBC driver was written
in Visual Basic.

7 SOLGold - [untitled)

File Edt Databaze QOptions Help

~Tool Box
Hun sOL |1ables | Clear | [ I o I - I o I B I e I B I
. Results
custom_num |fname ‘Iname |cumpany |addressl -
Zh[ﬁamla Sadler Sports Spot 785 Geary 5t
2 103 Philip Currie Phils Spoits 654 Poplar
3 104 Anthony Higgins Play Ball! East Shopping Cntr.
4 105 Raymond Yector Los Altos Sports 1899 La Loma Drive
5 106 George ‘Watson ‘Watson & Son 1143 Carver Place
1 107 Chailes Ream Athletic Supplies 41 Jordan Avenue
7 108 Donald Quinn Quinns Sports 587 Alvarado
8 109 Jane Miller Sport Stuff Maylair Mart
9 110 Roy Jaeger AA Athletics 520 Topaz Way
10 111 Frances Keypes Sports Center 3199 Sterling Court
11 112 Margaret Lawson Runners & Dthers 234 Wyandolte Way
12 113 Lana Beatty Sportstown 654 Dak Grove
13 114 Frank Albertson Spoiting Place 947 Waverly Place
14 115 Alfred Grant Gold Medal Sports | 776 Gary Avenue _ILI
»

18 Rows And 10 Columns

SCAL [NUM [caPs |

See ALso

For more information, look up “Visual Basic” in the Help index.
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Borland Delphi

You can use SQL-Retriever to bring remote Unix data to Delphi’s object-
oriented visual programming environment. Delphi’s database tools and data-
aware components allow external data to be manipulated in sophisticated
data-access programs. Using Delphi’s data-aware controls, you can view live

data while you design your application, letting you immediately see the
results of database queries.

ai Bd2 Demo M= E3
Ocean Paradise, Inc.
Sales Database
Filker/Seaich Criteria I Eilered Records Only
Los Altos - Eind Mext Find Erior I
Customer an Last Name |Enmpany |Addlass |Dly |Stat =
l 101 | Pauli All Sports Supplies 213 Erstwild Court Sunnpvale CA,
| | 102 | Sadler Sparts Spat 785 Geary St San Francisco CA,
| | 103 | Cummie Phils Sports E54 Poplar Palo Alto Ca,
| | 104 | Higgires Play Ball E ast Shopping Crir. Redwood City Ca
| | 105 |Vector Los Altas Sparts 1899 La Lama Diive Los Altos CA
| | 106 Watson Watson & Son 1143 Carver Place Mountain View Ca o
[« _>|_I
fL Close

See ALso

For more information, look up “Delphi” in the Help index.
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Powersoft PowerBuilder

Using SQL-Retriever, you can easily develop high-performance PowerBuilder

applications that access data from remote UNIX databases. PowerBuilder’s
DataWindow objects shield you from having to deal with databases to get
and send data. All the necessary SQL is created dynamically. DataWindows
can be built from several data sources and presentation styles provided by

PowerBuilder.
[ [ (2] =]
Eille Edit #indow
Blo| ®| Blsla|
Maintain Customers I [=] B3
Maintain Stock [_ (O]
Unit Price Manufacturer's Code Description o
@’1 g ANT tennis racquet
20 ANZ volleyball net
840 ARZ volleyball
48 ANZ tennis ball
126 HRO hasehall
~ 250 HRO hazehall gloves
480 HRO foothall J
Unit Price: (19 I Stock Number: (5 I
Manufacturer's Code: |ARZ v. i
M T . M. . er's Name|[ =
Description:

[Feady

MNRG

MNorge

See ALso

For more information, look up “PowerBuilder” in the Help index.
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Troubleshooting

If you encounter problems when using Vision2K software, look up
“troubleshooting” in the Help Contents, and then follow the step-by-step
instructions to resolve the problem. In addition, Help gives information
about how to contact Technical Support if you cannot resolve your problem.



The Possibilities

Look here to discover some of the additional
facilities provided by SQOL-Retriever that aren’t
contained in the Lite version.

You’ll learn about how you can browse through
UNIX files, run UNIX programs, set up remote
printing, and send messages to other users.

For more information about these exciting
possibilities, look up the topic in the Reference

book or online Help.
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Browsing UNIX servers

SQL-Retriever provides browsing facilities that enable you to browse remote
UNIX hosts as easily as browsing the local hard disk. Users can use UNIX
Neighborhood or Host Explorer to browse the files and folders on a UNIX
computer.

Browsing UNIX servers

You can use Unix Neighborhood or Host Explorer to see what’s on a UNIX
computer. The Unix Neighborhood browser provides a similar look and feel
to Network Neighborhood, and Host Explorer is similar to Windows
Explorer and gives you a view of the UNIX server’s contents as a hierarchy
or “tree.” Files can be moved, copied, deleted, or renamed. You can move or
copy files within one UNIX file system; from one UNIX system to another;
or between a UNIX system and your PC.

:'-'g Exploning - /fjupiter fhome/ jupiter fstevel M= B

File Edit “iew Help

Iastevel j c',"ol
Eg Huosts - README
= jupier [ miile

ElD harme

El[:l [Lpiter
: LedT5] stevel
= g Mars -
« | v
|For Help, click Help Topics on the Help menu. i

See ALso

For more information, look up “browsing” in the Help index.
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Running a UNIX program

You can use the Remote Program Starter application supplied with
SQL-Retriever to start programs on remote UNIX systems that do not
require user interaction, such as daemon processes or other background
tasks. Remote Program Starter settings can be stored in a Remote Program
Starter settings document. You can start a UNIX program by double-clicking
the document icon. By default, you do not see any status or error messages,
nor text output by the UNIX program. To view this output, you need to edit
the Program properties and change View Reply to Always or On Data.

.‘:l Untitled - Remote Program Starter EE

File  Propertiez Help

Huost: Iiupiter j

Command: Iwhu j

Bun Eruwse...l Cloze | Help |

See ALso

For more information, look up “executing remote programs” in the

Help index.
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Printing

SQL-Retriever allows Windows and UNIX applications to share printers.
You can print from a UNIX application to a printer attached to a PC, or you
can print from a Windows application to a UNIX printer. To find out about
printing UNIX files on your PC, look up “printing, from UNIX to a PC” in
the Help index. For information on printing PC files on UNIX, look up
“printing, from a PC to UNIX” in the Help index.

B3 Printers [_ O] =]

Fil=  Edit “iew Help
I@ Printers j
& =

Add Printer Apple QAr5-PS 810 b
Lazerwrter 1| on LM
MT

w
4| | 3

|'I ohject(z] zelected i
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Displaying messages

SQL-Retriever provides enhanced messaging facilities that allow you to send
text, sound or video clips to explain your ideas to a co-worker. The Message
Pad program displays text messages or runs the appropriate viewer program.

Text messages

Another Vision2K user can send a text message to you directly from User
Viewer, using the Send Message option. The text appears in Message Pad on
your PC. In addition, if you are logged in to a UNIX system with a terminal
connection then any messages sent to your username will be displayed in

Message Pad.

K4 Message Pad !E
o ———————————————————————— |
From : stevel 10f1

The Sales ing has been rescheduled for 2pm

£

Sound messages

Another Vision2K user can send a sound message (.WAV or .MID) to you
using User Viewer. The sound icon appears on Message Pad, and the
appropriate sound player is opened. You need to click Play to hear the

message.
[
EA Message Pad = =]x=]
e —————————
From : 2of2
@é & mgMEMD WAV - Sound Recorder [H[E E3
0 File Edit Effects Help
MEMDO \WAY

Position: ﬂ Lenagth:
0.00 sec 057 sec.
4

-~

See ALso

For more information, look up “messages” in the Help index.
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Video messages

Another Vision2K user can send a video clip to you as a message using User
Viewer. The AVI icon appears on Message Pad, and Media Viewer is opened.
You need to click Play to watch the video clip.

4 Message Pad = =] =]
i/ mgSALES.AVI =]

SALES.AVI

& moSALES.AVI- Media Player (stopped)
File Edt Device Scale Help

J K|
000 1.00 200 300 400 500 600 7.00 400 300 1035

v m 2] | m ] Ll.:.|| 00.00 fsec)

Other message types

Message Pad can receive messages in many formats, including ASCII text,
sounds, video clips, Word documents, and Windows bitmaps. When a
multimedia message is received, it appears as an icon on a page, and the
appropriate viewer program is opened. When you close the viewer, the
message remains on Message Pad. You can review the messages you have
received by clicking the right mouse button, and clicking Next Message or
Previous Message. Double-click a message icon to run the viewer and see or
hear the message again. When you close Message Pad, all messages will be

deleted.

You can copy text from Message Pad by selecting it with the mouse, and
pressing CTRL+INS. To save any other form of message, open it in the viewer
program, then use the Save command on the File menu to name and save a

file.
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Sending messages

The User Viewer program shows all the PCs currently running Vision2K, and
allows you to send simple text messages or multimedia messages to them.

Sending a text message

You can send a simple text message from User Viewer by clicking on a PC
icon with the right mouse button and clicking Send Text Message.

Fle “iew Options Help
B lmlal 2l I
=15end Text Message [ 2] =]

=]
E‘ Status Close |

Meszage:

The sales meeting has been rescheduled for 2pm.

Sending a multimedia message

You can send the following types of message by dragging a file from My
Computer or File Manager (for Windows NT 3.51) to a PC icon in User
Viewer:

«  Text files (*.TXT)

«  Word documents (*.DOC)

« Animation files (*.AVI)

« Bitmap files (*.BMP)

«  Midi sequence files (*.MID)

« Sound files (*.WAYV)

The file is copied to a temporary location on the target PC and Message Pad
allows the recipient to view or play the message. When Message Pad is
closed, the temporary files are deleted from the PC.

See ALso

For more information, look up “messages” in the Help index.
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Managing SQL-Retriever remotely

SQL-Retriever is designed so that a System Administrator can use SCO
SuperVision to remotely manage, configure and control large numbers of
Windows PCs. SuperVision provides facilities for:

« Distributing data files

+  Managing users’ desktops

« Creating script files to perform tasks on PCs
«  Controlling and monitoring PCs remotely

A utility called Data Source Export is provided with SQL-Retriever that
allows a selection of data sources to be saved as one Registry file. This can
then be distributed to other users using SuperVision. For more information,
look up “data sources, distributing with SuperVision” in the Help index.

SuperVision software must be licensed and installed on a UNIX server, and
on the System Administrator’s PC. There is no need to install additional
software on the PCs to be administered providing SQL-Retriever is already
installed.

SQL-Retriever users can be remotely managed even when PCs are switched
off, disconnected from the network, or on a remote site using dial-up access.

Note When SuperVision is available, the System Administrator can browse
your files, find out which programs are running, and even see what is on
your PC screen. If you do not want this functionality, click the Start menu,
point to Settings, click Control Panel and then double-click Vision Services.
Click the Admin tab and disable the Allow This PC to be Administered by
SuperVision option.
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